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Introduction

These notes describe how to run MSC.EASY5 2004 on a computer running a Windows® 
(Intel or compatible processor) or selected Unix operating system architectures. You should 
review these notes before running MSC.EASY5 2004. We recommend that you keep these 
notes with the MSC.EASY5 User Guide for future reference. 

These notes are stored in folder . . .\Documents\release  in Adobe Acrobat Portable 
Document Format (PDF). Adobe Acrobat Reader Version 6.0 is provided free with 
MSC.EASY5 for reading PDF documents. For a complete list of new enhancements for 
MSC.EASY5 2004, please refer to the previously mentioned folder. 
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WELCOME

Conventions Used in This Guide

Conventions Used in This Guide

This guide uses the following text conventions to identify functions and procedures:

� Courier font indicates a file name or text to be entered.

Enter open_loop in the input field.

� Text enclosed in angle brackets indicates that you are to press a key.

Press <Enter>.

� Most keyboard shortcuts require that you press the Control key together with another key 
simultaneously and are written as shown linked with a plus sign.

Press Ctrl+S.

� Text in all caps followed by a direction (right or left) indicates that you are to use the 
specified mouse button in the following ways.

CLICK-L Click and release the left mouse button.
CLICK-R Click and release the right mouse button.
DOUBLE CLICK-L Click the left mouse button twice in rapid succession 

and release.

� Text in a bold Arial font with right angle brackets between words indicates that you select 
a menu and subsequent submenus with your mouse.

Go to File > Print Preview to view your document.

� Arial font text in brackets indicates that you are to left click a push button in the window.

Click [OK] to close the window.

� Several icons are also used throughout this guide to bring your attention to certain items.

Items preceded by an icon of a flag person are important items. Important items 
contain critical information to the operation and installation of MSC.EASY5.

Items preceded by an exclamation point in a triangle are warning items. Warning 
items could affect your computer, your operating system setup, or your 
MSC.EASY5 setup. Please pay special attention to all warning items.

Items preceded by the words “NT only” apply only to the Windows NT or Windows 
2000 operating systems. “Windows NT/2K” refers to both Windows NT and 
Windows 2000.
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MSC.EASY5 2004 is a new release with the primary new feature being the use of MSC’s 
license management, and a few enhancements to the current product. For a more detailed 
description of the new features and enhancements, see "Guide to 2004 New Features" on page 
9. This section is intended for current users that want to quickly learn about the new V7 
features. Please also see "MSC.EASY5 2004: Bug Fixes and Enhancements" for a more 
complete list of bugs fixed and enhancements provided with MSC.EASY5 2004.

New MSC licensing allows user much greater flexibility in use of licensed 
features, and distributed MSC world-wide support for licensing and 
installation. The new license manager also supports MSC.Software’s 
MasterKey license. See Chapter 2, Basics in the MSC.EASY5 User Guide for 
complete information.   

Two new platforms have been added to MSC.EASY5:

�  Linux IA32, based on RedHat 9.0 Linux

�  HPUX-IA64 Itanium

Two new compilers are supported on Windows:

�  Intel Visual Fortran 8.0

�  GNU/GCC v3.2.3 with new improved debugger 

Updated libraries include:

� Multi-Phase Fluid library, allows reversible flow, and has improved 
compressor and condenser models. 

� Updated Gas Dynamics library, with steam properties, and multi-
configurable components. 

� An updated Hydraulics library, utilizing configurable components, is 
scheduled for release shortly.

Flexible License 
Management

New Platforms and 
O/S Including Linux

New Compilers for 
Windows

Updated Libraries

Upcoming 
Libraries

WH A T ’S  NE W 1



6         MSC.EASY5 2004        

WHATÕS NEW

Conventions Used in This Guide

Improved export method makes it easier to setup and export an EASY5 
model to Simulink, ADAMS, and the Matrix Algebra Tool. If you use the 
EASY5 interface feature with any of these tools, you should read the 
section, "Export Model Feature" on page 11.

The proprietary BCS Gear integration method was improved. Under certain 
dynamic conditions, such as lubrication dynamics where the pressures are 
small, you may see a dramatic improvement in simulation speed.

Other miscellaneous improvement to the GUI are:

� Improved screen annotation, allowing you to format schematic data display. 
For more details see section "Format Data Display On Schematic Diagram" 
on page 16.

� Improved export functionality (allowing model to be exported to various 
other formats).

� Improved plot data resolution (for use in external programs, in particular). 
Plot data is now saved as double precision data. 

� Several new capabilities for macro library developers.

� Improved diagnostics during model executable build stage.

� Improved model/library reconciliation process, also now automatically 
augments existing ported connections, if appropriate.

� Ability to define 2D states in Fortran/C components.

� Multi-line table data can now be input into MAT (via an EMX file).

� Improved timed switch state performance.

� Improved use of macro configurations, including use of revisions (allowing 
updated library components to be more easily phased in).

� Increased maximum number of plot displays from 250 to 2000, plot 
variables from 1000 to 8000.

Improved EASY5 
Model Export to 
Simulink, ADAMS 
and EASY5/MAT

Improved BCS Gear 
Integrator

Miscellaneous
Improvements
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MSC.EASY5 7.0+ model files and library files are easily converted to MSC.EASY5 2004 
files. You should have no problem opening version 7.0+ models in MSC.EASY5 2004. Just 
run MSC.EASY5 2004 and open the Version 7.0+ model and MSC.EASY5 will 
automatically update your model. Note, however, that models created in MSC.EASY5 2004 
may not be downwardly compatible.

If you need to convert MSC.EASY5 Version 6.0 models to MSC.EASY5 2004, you should 
read "Converting MSC.EASY5 V6 Models to V7.0+" on page 63.

CO N V E R T I N G  V7.0+ EX I S T I N G  
MO D E L S  A N D  L I B R A R I E S 2
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CONVERTING V7.0+ EXISTING MODELS AND LIBRARIES

Conventions Used in This Guide
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MSC.EASY5 2004 is quite similar to Version 7. The major new feature, is the license 
manager, which uses MSC.Software’s (FlexLM-based) license management method.  This 
new license manager also allows MSC.EASY5 to be incorporated into the (MSC) MasterKey 
license. 

New License Manager

The new license manager provides you maximum flexibility in accessing various options and 
application libraries. It lets you dynamically turn on and off license features while running 
MSC.EASY5, unlike the previous version that required you to exit MSC.EASY5, and select 
the license configuration before re-launching MSC.EASY5. 

For example, you can be using the Thermal Hydraulic Library build license, which enables 
you to create and modify models with components from this library. When finished building 
the model and creating the executable, you can “release” this license feature, and just use the 
run-time license to run simulations and other analyses. By releasing the build license, other 
users can access this license. See the MSC.EASY5 User Guide, Chapter 2, Basics for complete 
information on how to use the new License Manager capabilities. 

The first time you start MSC.EASY5, all available features from the license file are checked 
out for use. On subsequent invocations of MSC.EASY5, you can use the Licensed Features 
dialog to control what license features are checked out at start up. 

The Licensed Features dialog is used to control and verify current settings for license features 
available and/or used by MSC.EASY5. An example of this dialog window is shown in Figure 
1. To invoke this dialog, select the menu item Help > Licensed Features....

The Feature Selection tab is used to view and control the license features used by 
MSC.EASY5.  There are two main window panes in the Feature Selection tab: one for 
MSC.EASY5 Features, and for Application Library Features.  The latter section is only 
applicable when a Model Building feature is checked out.

Each MSC.EASY5 license feature is listed on an individual row, with 3 columns of data:  
Select for Checkout, Checkout at Startup, and Status. The “Select for Checkout” setting 
indicates whether the license feature is currently checked out, “Checkout at Startup” whether 
or not this feature should be automatically checked out during startup, and “Status” the 
current status of this license feature. 

GU I D E  T O  2004 NE W  FE A T U R E S 3
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GUIDE TO 2004 NEW FEATURES

New License Manager

A green “Checked Out” status value indicates that the license feature is checked out, while a 
red value indicates an error. To modify any of the settings, simply make the appropriate 
changes, and select either the OK or Apply Checkout button. To obtain more information on 
each license feature, select the License Information tab. Please note that the License Server 
information is only applicable if you are using a License Server, that is, if you have a 
“concurrent” or “campus” type license.

To release a license, un-check the “Selection For Checkout”, and then select the Apply 
Checkout button. 

Figure 1: MSC.EASY5 License Dialog 
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GUIDE TO 2004 NEW FEATURES

Export Model Feature

Export Model Feature

MSC.EASY5 2004 includes the “Export Model As...” menu item, shown in Figure 2, to export 
the EASY5 model to different model executables, including:

• MAT EMX Function - executable called by the Matrix Algebra Tool

• ADAMS External Systems Library - the executable model called from an 
MSC.ADAMS model.

• MATLAB/Simulink S-Function - creates all the necessary files to run in a co-simula-
tion with Simulink. 

• MATRIXx/SystemBuild UCB - creates all the necessary files to run in a co-simulation 
with SystemBuild. 

The export features have been enhanced in MSC.EASY5 2004 are explained in the next 
sections. 

Figure 2: MSC.EASY5 Export Model Options 
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GUIDE TO 2004 NEW FEATURES

Export Model Feature

MATLAB/Simulink Export 

The previous version required several windows and menu selections to build the Simulink 
interface model. For example, there is no longer a need to set the Matlab Interface option. 
This has all been replaced with the single form shown in Figure 3. To open this form, select 
the Build > Export Model As... > MATLAB/Simulink S-Function menu option.    

Select one of the Export buttons to export the EASY5 model and create all the files needed 
to run EASY5 in a co-simulation with Simulink. Note the this form is very similar to the 
simulation data form, and provides most of the same functionality.

MAT EMX Export 

The method to export an EASY5 model to an EMX file that is called from MAT, has been 
simplified. The export is setup with the data form shown in Figure 4. To open this form, select 
the Build > Export Model As... > MAT EMX Function  menu option. 

Figure 3: Export MATLAB/Simulink Data Form 
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GUIDE TO 2004 NEW FEATURES

Export Model Feature

This new method gives you the capability to include temporary settings files, auxiliary input 
files, and load an initial operating point file. 

Export to MSC.ADAMS

The method of exporting an EASY5 model to an ADAMS External System Library has also 
been simplified with a simple data form, shown in Figure 5. To open this form, select the 
Build > Export Model As... > ADAMS External System Library menu option. This simple form 
is self explanatory. 

Figure 4: Export MAT EMX Data Form

Figure 5: Export ADAMS External System Library Data Form



14         MSC.EASY5 2004        

GUIDE TO 2004 NEW FEATURES

Improved EASY5/ADAMS Interface

Improved EASY5/ADAMS Interface

The data interface between MSC.EASY5 2004 and MSC.ADAMS 2005 has been improved 
to allow export of EASY5 parameters and output states and variables, using the data form 
shown in Figure 5. This data can then be imported and used within MSC.ADAMS 2005. For 
example, from within ADAMS, you can modify the MSC.EASY5 parameters and run 
MSC.ADAMS. You can also take the MSC.EASY5 outputs and plot it using ADAMS’s 
plotter. Note that this will only be available with the release of MSC.ADAMS 2005. 

NOTE: MSC.ADAMS 2005 will be released after MSC.EASY5 2004, in the 3rd 
quarter of 2004. These enhancements only apply to MSC.EASY5 2004 
and MSC.ADAMS 2005. 

The co-simulation mode has also been dramatically improved, by using linear interpolation 
between communication calls. Using this new method, the execution speed is over 100 times 
faster than the previous version! Note that this co-simulation improvement will only be 
available with the release of MSC.ADAMS 2005.

NOTE: When first installing MSC.EASY5, you need to setup the EASY5/

ADAMS interface. This only needs to be done one time. To do this, 

open an EASY5 Command Shell, and enter:   

             install_adams_controls.ksh adams03   

or, in place of  “03”, enter your ADAMS version (e.g. “05” for v2005). 
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GUIDE TO 2004 NEW FEATURES

Improved Component Documenting

Improved Component Documenting

The component documentation has been improved with better formatted text, as shown in 
Figure CC, and also with a new “information” feature. An information “i” button is placed 
next to data fields that contain several selections. Information explaining these selections is 
provided by selecting the “i” information button. This pops up a dialog with information, an 
example of which is shown in Figure 6. 

Figure 6: New Component Information Feature
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GUIDE TO 2004 NEW FEATURES

Format Data Display On Schematic Diagram

Format Data Display On Schematic Diagram

In EASY5, analysis results can be displayed on the schematic and either be tied to a specific 
component icon or placed anywhere on the schematic using a text icon. In MSC.EASY5 
2004, you can specify the data format of the display, as shown in Figure 7. 

The data format is defined by inserting a C-code format within the data name, such as [%.4f] 
as shown in figure DD. An example of the resulting display is also shown in the figure.  

Figure 7: Data Display Format
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GUIDE TO 2004 NEW FEATURES

Library Updates

Library Updates

The following MSC.EASY5 application libraries were updated:

Gas Dynamics gd v3.2.0
Multiphase Fluid vc v3.0.0

Obsolete Features

Obsolete compilers no longer supported:

� Dec Visual Fortran (DVF) 5.0 

� MS Fortran PowerStation

� GNU EGCS version 1.1.2   

Obsolete platforms and operating systems no longer supported: 

� Windows 95 and 98

� Harris PowerHawk
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GUIDE TO 2004 NEW FEATURES

Obsolete Features
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This section discusses how to run MSC.EASY5 on both the Unix and Windows operating 
systems. Since MSC.EASY5 is based on an X Windows environment many of the commands 
are similar for both operating systems.

MSC.EASY5 has long been available as an X Windows™ application for Unix systems, and 
with the release of Version 5.2 it also became available to run as a Windows application on a 
personal computer or network. Although MSC.EASY5 can run under Windows, it is not 
considered a true application for Windows; rather, it remains an X Windows application that 
runs on 32-bit Windows platforms with the windows display managed by the HCL Exceed® 
X server software.

The advantage of this is that all users, whether running under Unix or Windows, experience 
a similar MSC.EASY5 look and feel. As a result, you can easily move across all platforms 
and be familiar with and know how to use MSC.EASY5; there is no need to learn special 
commands or different methods. Generally the MSC.EASY5 documentation applies to both 
Unix and Windows platforms.

Sections of this document that apply to Windows systems only will be designated with the 
heading “Windows Only” and sections that apply only to Unix systems will be designated as 
“Unix Only”. In addition, see "Notable Differences Between Unix and Windows" below for 
known differences between these types of systems.

4RU N N I N G  MSC.EASY5 
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RUNNING MSC.EASY5
Notable Differences Between Unix and Windows

Notable Differences Between Unix and Windows 

� The most obvious differences between the Unix and Windows operating systems is with 
respect to file naming because of standards that have evolved separately for many years. 
Differences arise in the following:

— Case. Unix is case sensitive and UPPER versus lower case convention is followed; 
in Windows it is not. For the NT file system (NTFS) the proper case is shown, but it 
is not required for specifying a file.

— Pathnames. Windows uses back slashes; Unix uses forward slashes.

— White space. Windows allows spaces in file and path names, such as C:\ Program 
Files in path and file names. This is allowed in Unix when the path is enclosed by 
quotation marks.

— Concatenation. Windows uses the semicolon (;) as a string delimiter; Unix uses the 
colon (:).

— File completion. In Windows, there is no equivalent for the Unix capability to enter 
<Esc> to complete file names entered.

� Limited shell commands are available on the Windows side. The (NT) MS-DOS 
Command Prompt is still very DOS-like and is not likely to change.

� Most Windows programs are started with graphical icons (or shortcuts), not with shell 
commands.

� MS-DOS Command Prompt shells are not multitasking. For example, you cannot spawn a 
background job by appending an ampersand (&) to a command.
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RUNNING MSC.EASY5
Windows Only - Platform Notes

Windows Only - Platform Notes

Although the various Windows operating systems use a common Windows desktop and user 
interface and execute MSC.EASY5 in a 32-bit computational environment, there remain 
some significant differences in their system architecture and in the features that they support. 
Refer to the section "Notable Differences Between Unix and Windows" on page 20 for more 
information.

Notable Differences Between Windows 9x/Me and Windows NT/2K/XP

• MS-DOS Command Shell. There is no scrolling capability, more limited display 
and edit capabilities, and no enhanced command language for Windows 9x/Me.

• Security. There is very limited security under Windows 9x/Me.

• Multiuser support. There is very limited multiuser support under Windows 9x/
Me.

• Services. There are no services for Windows 9x/Me.

• MS-DOS Console. There is no centralized MS-DOS Console for Windows 9x/
Me.

• Task Manager. There is no real equivalent under Windows 9x/Me.

• Pathnames. White-spaced paths require enclosure by double quotes.

• Robustness. Windows 9x/Me  is more prone to system crashes because of a more 
vulnerable system architecture.

• Environment variables. Global environment variables are set in file 
AUTOEXEC.BAT and require restarting the computer to take effect under Windows 
9x/Me. Windows NT/2K/XP manages global variables with the Control Panel. 
Please see section "Global Variables" on page 41 for details. 

• Registry. Many of the system Registry settings are in different locations in 
Windows 9x/Me.

Based on experience with these two operating systems, it is clear that Windows NT/2K/
XP is a more flexible, user-friendly, and more robust operating system. Therefore, the 
clear recommendation, especially in a corporate environment or where security is an 
issue, is to use Windows NT/2K/XP.
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RUNNING MSC.EASY5
Unix Only - Platform Notes

Unix Only - Platform Notes

NOTE: Future support for specific Unix platforms and operating system 
versions cannot be guaranteed with future versions of MSC.EASY5. 

SGI

• When starting MSC.EASY5, the opening menu may look compressed, showing 
only the dialog title area. When this occurs, use the window manager close function 
to close this dialog (CLICK-L the horizontal rectangle from the upper left box). 
Then, select the MSC.EASY5 File menu to give you a pull-down menu with many 
choices, including New. 

• The Fortran compiler file libftn.so must be installed in the /usr/lib32 or /
user/lib64 directory. If this file is not installed as part of the Fortran compiler 
installation, you cannot build the MSC.EASY5 executable model.

• Starting with EASY5 Version 5.3.1, the SGI_ABI environment variable is set by the 
library directory being used. Starting with EASY5 Version 6.0.4, this setting is either 
-n32 or -64.

• R4000 chips (MIPS-2 architecture) are no longer supported.

• Compatibility:  MSC.EASY5 7.x minimum OS version supported is IRIX 6.5.

IBM RS6000

• Starting with EASY5 Version 6.0.2, trapping of floating point exceptions is enabled.

• If you have external Fortran that needs to be linked with your EASY5 model, add 
the -qextname option when compiling. This forces the compiler to conform to the 
f77 compilers on other platforms. 

• Compatibility:  MSC.EASY5 7.x minimum OS version supported is AIX 4.3
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RUNNING MSC.EASY5
Unix Only - Platform Notes

Sun Solaris

• Compatibility.  MSC.EASY5 version 7.0+ requires compilers at level 5.0 or higher, 
and an OS of 2.6 or higher. 

• Compilation Options. The f77 compiler delivered on Sun Solaris machines 
includes a Fortran compilation option called -fast. If your compiler has this 
feature, it is strongly advised that you use this option when running MSC.EASY5, 
to greatly increase the speed at which your simulations run. In the newer 64-bit oper-
ating systems, this option has been known to decrease runtimes by a factor of four. 
To set this option, enter the following command (to set an environment variable in a 
C shell) at a Unix prompt before running MSC.EASY5:

setenv ftnopt “-c -fast“

• You must be able to run the f77 and ar commands. To test this, enter:

which f77
which ar

If these commands do not return a pathname, then they are not in your search path 
and you must locate them and add the command paths to your path variable. 
Standard locations are (yours may differ):

For f77, add /usr/lang/bin
For ar, add /usr/ccs/bin

• If your Fortran compilation fails, you may also need to set the LD_LIBRARY_PATH  
environment variable.  These directory pathnames depend on how your Fortran 
compiler was installed and may be different from the listed names. To see what the 
variable is set to, enter:

env | grep LD_LIBRARY_PATH

If it is not set correctly, then add this as a colon extension to the end of the variable 
using the appropriate Unix command. For example, if you need to append /opt/
SUNWspro/lib  to the existing LD_LIBRARY_PATH variable, enter the following 
C Shell command:

setenv LD_LIBRARY_PATH $LD_LIBRARY_PATH:/opt/SUNWspro/lib

This should be added to your .profile, .login, or .cshrc file. 
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RUNNING MSC.EASY5
Windows-Specific Notes

 HP-UX 700

• Compatibility:  MSC.EASY5 7.0+ is compatible with HPUX 11.0+. 

• If you have external Fortran code that needs to be linked with your MSC.EASY5 
model, add the +ppu option when compiling. This forces the HP compiler to 
conform to the f77 compilers on other platforms. 

Windows-Specific Notes

Windows Folders

A folder is the terminology used throughout Windows to indicate a directory. During 
your software installation, EASY5 Setup automatically sets an environment variable 
WSLOGIN to your designated MSC.EASY5 working folder path. By default, EASY5 
Setup suggests a working directory, depending on your operating system (or install type), 
as follows: 

Windows NT/2K/XP: x:\EASY5data\user_name 

 where:  user_name comes from your System

Windows 95/98/Me: x:\EZ5data

Demonstration Disk: x:\EZ5demo

where: x = target disk

The working folder path must be in a separate folder from the MSC.EASY5 program 
files.

The MSC.EASY5 Working Folder path is the top-level folder from which you run 
MSc.EASY5. Every time you launch MSC.EASY5 from an icon or an EASY5 Command 
Shell, you are automatically started in this folder. When you start MSC.EASY5 from an 
EASY5 Command Shell, however, the current folder path is locally assigned as the 
working folder.
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RUNNING MSC.EASY5
Windows-Specific Notes

   Per-User Setup

Ideally, each MSC.EASY5 user of your computer should assign and use a separate 
working folder. For a common group installation, a system default working folder is also 
assigned as path x:\EASY5data\default during program installation, and used only 
when no Per-User Setup has been performed. 

Each MSC.EASY5 user other than the original installer should perform a “Per-User 
Setup” from the  Start Menu > Programs > MSC.Software>MSC.EASY5 2004 > Per-User 

Setup shortcut. When this is invoked EASY5 Setup prompts for and assigns a personal 
working folder, and properly configures other personalized MSC.EASY5 (and Exceed) 
registry and environment variable settings. 

NOTE: Running a Per-User Setup requires a minimum of  Power-Users group 
privileges.

You can start MSC.EASY5 by using either of the following methods:

¥ From any MSC.EASY5 icon or shortcut (in the Start Menu or your Desktop).

¥ From any EASY5 Command Shell or EASY5 Korn Shell window.

Starting from an Icon

To launch MSC.EASY5 from an icon, DOUBLE CLICK-L the icon. The icon executes 
a batch (script) file, which starts the MSC.EASY5 program files in your EASY5 working 
directory. 

A background window displays and remains throughout your MSC.EASY5 session. 
This window displays messages about your MSC.EASY5 graphical process, which runs 
in front of this window and is called EASY5x. The Exceed X server is also started 
automatically as needed.

When you quit MSC.EASY5, all associated windows, including the background 
command window, are closed. If your Exceed “Enable Server Reset” configuration 
setting is deactivated, the Exceed X server may remain on the Taskbar. To manually quit 
Exceed, CLICK-R on the Exceed icon on your Taskbar and select Close.
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Starting from an EASY5 Command Shell

An EASY5 Command Shell is simply a command shell environment where an 
MSC.EASY5 environment has been pre-initialized. To start an EASY5 Command Shell, 
go to Start > Programs > MSC.Software>MSC.EASY5 2004 > Shell > MSC.EASY5 Command 

Shell. The EASY5 Command Shell differs from an MS-DOS Command Prompt in that it 
automatically starts in your MSC.EASY5 working directory and sets all MSC.EASY5-
related environment variables. The only difference between starting MSC.EASY5 from 
a command shell or from an icon is that when the MSC.EASY5 is complete, the 
command prompt window remains displayed. This can be useful when examining 
command histories.

From any EASY5 Command Shell, enter the following command to start MSC.EASY5:

easy5x

NOTE: A command shell is the standard mode for accessing MSC.EASY5 on 
Unix platforms. 

MSC.EASY5 provides a variety of command-line options, many of which can be very 
useful for performing simple operations. You can view them by entering easy5x -
help or by going to Start > Programs > MSC.Software>MSC.EASY5 2004 > Help > 

Command-Line Options.

So that EASY5 Command Shell windows are properly configured, each user (other than 
the original installer) must perform a “Per-User Setup”. Please see “Modifying Your 
MSC.EASY5 Command Shell Windows” on page 27 for more information on how to 
properly set up your EASY5 Command Shell window(s).

Those users migrating from Unix may have some trouble negotiating differences 
between Windows and Unix, because the Windows command shells are much more 
limited. Because we support both Unix and Windows platforms, we found that providing 
a Unix shell environment for the PC offers the most consistent background environment 
for our programs. As a by product of our own requirements, you can get a limited (Unix) 
Korn Shell environment.
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EASY5 Korn Shell

You can start a Korn Shell by going to Start > Programs > MSC.Software>MSC.EASY5 

2004 > Shell > MSC.EASY5 Korn Shell or by entering  sh -L  from any EASY5 Command 
Shell.

This is a stripped-down Korn Shell environment (provided through an OEM agreement 
with Mortice Kern Systems, Inc., for selected portions of its MKS Toolkit 6.2 software) 
containing only enough functionality to enable execution of our EASY5 Korn Shell 
scripts. If you feel more comfortable in a Unix-like shell environment, you can use this 
shell. In addition to the Korn Shell interpreter (sh.exe), the following Korn Shell 
commands are also supported:

You can access these commands from any EASY5 Command Shell or EASY5 Korn Shell 
window. 

NOTE: To enable Korn Shell commands from any MS-DOS Command 
Prompt, you need to set and modify several environment variables in 
your standard environment. See “MSC.EASY5 Environment Variables 
for Windows” on page 43 for more information.

Online Help

To obtain online help for these Korn Shell commands, enter the appropriate man 
(manual) page using the command:  man command_name, where command_name is 
a Korn Shell command, from any EASY5 Command Shell. 

Modifying Your MSC.EASY5 Command Shell Windows

All EASY5 Command Shell and EASY5 Background Shell windows are derivations of a 
MS-DOS Command Prompt window. If you want to change properties for a specific 
window, CLICK-R the window title bar, select Properties, and make your changes. The 
possible changes you can make, however, differ between Windows 9x/Me and Windows 
NT/2K/XP, with Windows 9x/Me unfortunately offering much less. 

cat date false ls od tr

chmod echo flip man ps uname

cp env grep more pwd vi

cut expr kill nm rm which
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Most importantly, Windows 9x/Me does not provide the capability for scrolling 
backwards or for resizing screens. Because of this limitation in scrolling, the more utility 
is used to display multi-screen output to EASY5 Command Shell or EASY5 Background 
Shell windows -- output displays and manually advances one screen at a time. An 
example of this mode occurs when you select the “MSC.EASY5 License Info” shortcut 
from the Start Menu. You can tell you are in this mode by looking for the word  more 
appearing in the window title and the prompt at the bottom of the window. To move to 
the next page, press <Spacebar>. To advance line-by-line, press <Enter>.

When installing MSC.EASY5, default settings provide scroll bars for any EASY5 
Command Shell windows. For a common-group installation all additional users (other 
than the original installer) of MSC.EASY5 will need to perform a “Per-User Setup”. This 
operation is accomplished using the shortcut from the Start Menu > Programs > 

MSC.Software>MSC.EASY5 2004 > Per-User Setup.

Unix-Specific Notes

Defining Print Options

Default printer setting should be defined by the system administrator when installing 
MSC.EASY5 on a Unix system. These options are defined in special files in the 
following directory:

<easy5_home>/easy5x/resource/settings

where <easy5_home> is the directory where MSC.EASY5 is installed. You can 
determine this directory by entering easy5x -home at a shell prompt:

The schematic print options used to print your model block diagram are set up in the 
schema_print_config  file. The plot print options used to print your plots are set up 
in the plot_print_config  file. If you wish to set up your own print options, you can 
copy these files to your login (home) directory or to your current directory and edit these 
files. These files are self explanatory and easy to understand. 

In the Print Options dialog, you can apply the printer options defined in these files by 
selecting Save/Restore > Restore from the $HOME directory or from the current directory.
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Printing 132-Character-Wide Files

MSC.EASY5 produces a few files that use up to 132 characters per line, such as the .apl 
print listing file. A special print script is available that can be used to print these files in 
either portrait or landscape mode on a standard 8.5- by 11-in sheet. Copy this script file 
to your login (home) directory, by entering:

cd ; cp <easy5_home>/resource/settings/print132 .

Windows and Graphics Display Anomalies

The following list includes some items that you should be aware of when running 
MSC.EASY5:

• In many dialogs, the <Return> or <Enter> key moves the mouse cursor to the next 
field, and at the end, it moves the cursor to a push button. Entering <Return> acti-
vates this push button. However, with Motif 1.2, the <Return> does not activate push 
buttons. Instead, use <Space bar> to select and activate the push button.

• Accelerator keys do not work if the keyboard caps are locked (a Motif standard). 

• The first time any window or menu displays there is a delay. In large windows, this 
delay can be as long as 8 sec. However, once a type of window has been opened, 
there is only a small time delay when it is reopened.

• On rare occasions, the keyboard may freeze, not allowing you to enter data. If this 
occurs, move the mouse cursor to the middle of the screen and CLICK-M. This 
should unfreeze the keyboard. 

• If your MSC.EASY5 windows pop to the foreground and background in a confusing 
manner, make sure that your window manager is not using the AutoRaise resource. 
AutoRaise causes windows to inappropriately move to the background. (Contact 
your system administrator to fix this.)

• You should never close program windows using the Window Manager close func-
tion. If this method is used, unpredictable program operation may occur. Always use 
MSC.EASY5-provided functions to close windows. 

• Changes to icon pin locations (changed with the Icon Editor) are not shown until the 
edited component is moved. (It can be moved to its own location.)

• If you are running MSC.EASY5 on a color workstation with displays of less than 8 
bit planes, you should force MSC.EASY5 to display in monochrome. The mono-
chrome mode is set by the environment variable WSMONO. To set this enter (in the C 
Shell) setenv WSMONO on.
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Case-Sensitive Character Contents

MSC.EASY5 now maintains the case sensitivity of character constants in User Code blocks 
and macros. A character constant is any string contained between apostrophes (') that occur 
in OPEN statements, CLOSE statements, and INCLUDE statements (if supported by the 
compiler). Previously, all character constants were automatically changed to uppercase.

Symbolic Debugger

Some platforms have more than one debugger. To set the debugger you wish to use, 
enter: 

setenv WSDEBUGGERNAME name  C Shell

export WSDEBUGGERNAME=name Korn Shell

Extended Select Method

Many of the list dialogs allow you to use the Motif extended select method to select more 
than one item from a list. You can select sequential items by pressing the <Shift> key 
while selecting the first and last item in the sequential list. You can select more than one 
item that may or may not be sequential by pressing the <Ctrl> key while selecting one or 
more items from the list. It is important to note that to deselect an item already selected, 
you must hold the <Ctrl> key while selecting the highlighted item you wish to deselect. 

Text Editor

When using the EASY5 text editor, do not use the keyboard Page Up and Page Down 
keys. Instead, use the provided scroll bars to page up and down. 
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MSC.EASY5 is automatically enabled for a specific Fortran and C compiler during program 
installation. Two steps are performed during this installation: 

� Binary files compatible with your selected Fortran compiler are installed on your computer.

� MSC.EASY5 settings are made in various script files and the Registry.

Specifically, the environment variable WSLIBDIR that is set in script file: 
(%EZHOME%\easy5x\bin\easy5x.ksh)  is used to link to the appropriate binary library 
folder. See the installation notes for more information on installing MSC.EASY5 and 
updating Fortran compilers.

Minimum Recommended Compiler Settings

Certain minimum Fortran compiler settings are highly recommended to maintain the standard 
functionality and behavior of MSC.EASY5. It is not recommended that you specify compiler 
settings that would conflict with these settings. The following minimum recommended 
Fortran compiler settings are recommended

:

Intel Visual 
Fortran 8.0

Compaq
Visual Fortran 
Versions 6.x GNU G77 3.2.3 (Mingw) Description

/c /c -c Compile only 
(See Note (2) 

/MD /MD Use multi-threaded DLL’s 
for linking
(See Note (3) 

/fpe:0 /fpe:0 Enables EASY5 FP error 
trapping 
(See Note 4)

/Qsave -fno-second-underscore See G77 help pages

-fno-backslash See G77 help pages

W I N D O W S  CO M P I L E R  
EN V I R O N M E N T 5
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Notes:

1 The /c option prevents an automatic link from occurring. Otherwise, the Create 
Executable command performs an unnecessary, duplicate link operation.  

2 The use of the /MD compile option is required because MSC.EASY5 libraries are 
linked with the multi-threaded system and compiler dynamic link libraries (DLL’s). 
This greatly improves the speed of creating an MSC.EASY5 executable and also 
assures you that the latest release of the system/compiler libraries are being used. 
You cannot link your model with MSC.EASY5 without this option.

3 The /fpe:0 option is used to enable floating-point error trapping only for the 
Compaq/Intel Visual Fortran compilers. If it is not present, MSC.EASY5 cannot 
properly notify you if a floating-point error occurred during an MSC.EASY5 
analysis execution.

Default EASY5 Executable Options

MSC.EASY5 can use two compilers when building your model executable, depending on 
whether or not you include a C-code User component. Of course, you can call external 
Fortran or C functions/subroutines from such code. Fundamentally, external Fortran or C 
code should be compiled in such a manner as to not conflict with MSC.EASY5 compilation 
or linking options.

MSC.EASY5 provides an automated way to compile external Fortran or C code for optimum 
compatibility with MSC.EASY5. For more information, see "Default C Code Compiler 
Options" on page 34.
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Default Fortran Compiler and Linker Settings

For reference purposes, the following table lists default commands and options used for 
MSC.EASY5 with your resident Fortran compiler:

NOTE: The “/Oxp” CVF compiler option is equivalent to the “/optimize:4 
/fltconsistency” options, and the “/MD” option is equivalent to the  
“/libs:dll /threads” options.

Description
Compaq Visual Fortran 6.x GNU G77

Intel Visual Fortran 8.0

Compiler command DF g77 IFORT

Compiler options 
(standard)

/c /MD /fpe:0 /Oxp /traceback -c -O
-fno-second-underscore 
-fno-backslash

/c /MD /fpe:0 /Oxp 
/traceback

Compiler options 
(debug)

/c /MD /fpe:0 /Oxp 
/traceback

-c -g 
-fno-second-underscore 
-fno-backslash

/c /MD /Qsave /fpe:0 
/Oxp /traceback

Linker command LINK g77 LINK

Linker options 
(standard)

/entry:mainCRTstartup

Linker options 
(debug)

/entry:mainCRTStartup
/debug

-g

Debugger invocation dfdev gdb msdev
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Default C Code Compiler Options

MSC.EASY5 also provides the capability of user-defined C-code components, in addition to 
utilizing a limited number of C code object code routines when creating model executables. 
For consistency with MSC.EASY5, the following compilation options are recommended 
withe the respective C compilers:   

This information can be helpful if you are creating your own external C code and want to link 
it in with your MSC.EASY5 model.

Overriding Default MSC.EASY5 Compiler Options

As part of the Create Executable process, the resident Fortran (and C) compiler compiles your 
model executable source. Typically, this is done using default MSC.EASY5 compiler 
options, with which all MSC.EASY5 analysis and application libraries are also compiled. To 
ensure compatibility with MSC.EASY5, you should use the default compiler options unless 
for some reason you cannot. For this purpose, MSC.EASY5 environment variables 
ftnoptand copt are provided. When these environment variables are detected, 
MSC.EASY5 uses their values to override default compiler settings. However, when using 
either ftnopt or copt, it is up to you to ensure that the options are compatible with 
MSC.EASY5, without which MSC.EASY5 functionality could be compromised.

Another important step is to first familiarize yourself with the available compiler options. 
Only a small fraction of what is available is specified in this document. The selected default 
option have been tested with a suite of internal test cases and demonstration models. This 
does not preclude that your model may require some tuning of these compiler options. Please 
refer to your resident compiler help for further information on compiler options.

Description
Microsoft Visual C++ 6.0+

GNU GCC

Compiler command CL gcc

Compiler options (standard) /c /MD /Gz /Og -c -O
-DEZLOWERUNDER

Compiler options (debug) /c /MD /Gz /Z7 /Od -c -g 
-DEZLOWERUNDER
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Example: Specifying Custom Compiler Options

The default optimization level for Compaq Visual Fortran 6.x compilers is level 4 
(corresponding to the /Oxp option). For certain models, this may not work to your 
satisfaction. In this case, set the default optimization level to a lower value, such as 1 
(allowable values are 0, 1, 2, 3, and 4). 

Set the ftnopt environment variable either locally or globally. See “MSC.EASY5 
Environment Variables for Windows” on page 43 for more information. 

From an EASY5 Command Shell, enter the command:

set ftnopt=/c /MD /fpe:0 /optimize:1 /traceback /fltconsistency

Then, use the easy5x command to subsequently start MSC.EASY5 from the same 
EASY5 Command Shell window. Setting a local environment variable in this way only 
affects processes started after the variable has been set and from the same window. If you 
have MSC.EASY5 running on your Taskbar, this has no effect. 

Alternately, you can set ftnopt globally in your standard environment to affect all 
processes on your computer. Please see section "Global Variables" on page 41 for details.

Accessing Dynamic Link Libraries

Dynamic link libraries (DLL) are object-code libraries that are resolved at run-time to your 
model executable to resolve unsatisfied external references. If you want your MSC.EASY5 
model to be able to use DLLs, you should not specify any special link options or link them in 
as external object code, because DLLs are not specified in the link step. MSC.EASY5 already 
uses many DLLs, located in the Windows system folder, for most of its Fortran and C 
libraries. Call the routines in your MSC.EASY5 model (with a user-defined component) and 
then ensure that the specific DLL is in your command search path. Most DLL’s are typically 
installed into a Windows system folder, which should already be in your current command 
search path. If not, you must modify your command search path by either setting or 
modifying the environment variable PATH in your standard environment (see instructions for 
setting ftnopt in the previous paragraph).

NOTE: The search order for using DLLs is always (1) the folder where the.exe 
file resides, (2) the Windows system folder, (3) the Windows 
(%WINDIR%) folder, and (4) your command search path given by 
environment variable PATH.
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Compiling External Routines

To compile external Fortran r C source code compatible with MSC.EASY5 -- specifically, 
ensuring their link compatibility with your MSC.EASY5 model, you can use a simplified 
method through an MSC.EASY5 command-line option. This method is only applicable from 
EASY5 Command Shell windows.

Then, to perform a compilation of one or more source files using default MSC.EASY5 
compile 
options, enter the following command, as appropriate:

easy5x -fc [-d] <filename(s)> External Fortran code compilation

easy5x -cc [-d] <filename(s)> External C-code compilation

Wildcard notation (e.g., using asterisks) for <filename (s)> can be used. Multiple files 
should be separated by a space. The optional “-d” argument is used to specify compilation 
for use with symbolic debugging (no optimization).

Using the Compiler Debugger

NOTE: The debugging capability is designed for experienced Fortran program-
mers to help track down errors in your model executable or related user-
defined code. This section describes use of symbolic debugging tools 
available with Microsoft Developer Studio based compiler products. 
While a rudimentary debugging environment is available with the GNU 
compiler suite, it does not function well enough where we can recom-
mend its use. Thus, if you need a symbolic debugging environment, we 
recommend using Compaq’s Visual Fortran 6.x (and MS Visual C++ 
6.0+ for C components).

Included with your (non-GNU) Fortran (or C) compiler is a source debugger environment -- 
all of the MSC.EASY5 compatible compilers utilize different versions of Microsoft’s 
Developer Studio debugging environment. The appropriate debugging program is provided 
with your Fortran compiler and is in your MSC.EASY5 command search path (by the 
environment variable PATH). 



Release Notes           37

WINDOWS COMPILER ENVIRONMENT

Using the Compiler Debugger

To debug your model, you first need to do the following:

1 Select Build > Create Executable With Debug. This compiles and links your model 
with debug options.

2 Click the [Execute/Debug] button from the respective MSC.EASY5 analysis data 
form. Only Simulation and Single Call analyses have this debug option. Starting the 
debug option causes the debugger program to open your model executable in the 
debug environment.

As the debug environment loads, you see a related debugger splash screen come up, followed 
by a window titled either “Microsoft Developer Studio” or “Digital Visual Fortran” 
(depending on the compiler installed), followed by your model executable name. 

The only source code files available for symbolic debugging are:

� Your Fortran model executable. This is the subroutine created by MSC.EASY5 (during 
a Create Executable with Debug operation) which comprises all your components and 
submodels, stored as file modelname.f.

� Any C-code components. All code from any C components in your model is stored in a 
single C source file named modelname_c.c.

� Your external routines or libraries. These must be compiled with the debug option and 
linked in with the Link External Object item on the Build menu (or other means described 
in your MSC.EASY5 User Guide). Refer to the section "Windows Compiler Environment" 
on page 31 for more information.

MSC.EASY5 analysis and component libraries are not available for debugging purposes, that 
is, there is no source code available for these routines for symbolic debugging.

Enabling the Debugger Toolbar

If you do not already have the Debugger Toolbar visible, go to View > Toolbars and make 
sure that Debug is selected. This makes debugging operations (e.g., Go, Step) available 
through toolbar buttons. Note that if you are using Microsoft Developer Studio or Digital 
Visual Fortran version 6.x, these debugging icons are enabled by default.
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Creating a Breakpoint

To create a breakpoint, open the source file you want to debug by going to File > Open. 

Typically, this is your model executable source file mymodel.f. Once the file has been 
opened, scroll down in the file and select an executable line of your model code where a 
breakpoint should be placed. Click [Insert Breakpoint] (debug) to set a breakpoint. You 
can also toggle breakpoints on and off by repeatedly clicking this button. A breakpoint is 
usually indicated by a filled (maroon) circle in the first column. You can place a 
breakpoint on any executable line of source code. Usually, only several are used to start 
you stepping through a portion of your model executable source code. You can go to Edit 

> Breakpoints to centrally manage (by selectively temporarily disabling) breakpoints.

It is recommended that you do not enter the routine name using the Breakpoint menu 
item. Instead, open the file and select breakpoints with your mouse or pointing device. 
This method is more reliable, because there is less chance of specifying an incorrect break-
point.

Activating Your Symbolic Debugging Session

To start your symbolic debugging session, you must first activate it, either from the [Go] 
button, or with the <F5> function key. Once your debugging session is activated, you see 
a new menu called Debug, which replaces the Build menu, displayed on your menu bar. 
A background shell is also temporarily displayed; this is your background job that starts 
your MSC.EASY5 model executable.

Stepping Through Your Code

To step through your code, use the provided buttons, the Debug menu items, or keyboard 
shortcuts. You can either Step into, Step over, Run to cursor, or Step out.

Starting, Restarting, Stopping

To initiate your model executable, you must click the [Go] button, or menu item. You 
can click [Restart] if you have passed your area of interest and want to start at the 
beginning. To stop, click [Stop Debugging] or use the appropriate Debug menu item.

Examining a Variable

You can display values of variables in your code in different ways. The easiest is to 
“hover,” or hold your cursor, over a variable with your pointing device; the value is then 
displayed. Other display options are available; see the Microsoft Developer Studio help 
for more information. 
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NOTE: Many MSC.EASY5 variable names have embedded blanks. Unfortu-
nately, many debugging programs do not know how to interpret such 
variable names, and the hover method does not work. In this case, 
enter the variable name with all blanks removed in the Watch window. 
You can enter new values by DOUBLE CLICK-L the Name column and 
entering the variable name without blanks. For example, for a variable 
S2 IN, enter the name as S2IN. Its value is immediately displayed in 
the Value column in the Watch window.

Determining Where the Model is Aborting

Other platforms (e.g., SGI) display termination information, called a trace back, directly 
in the MSC.EASY5 analysis program listing (APL) file. A trace back provides vital 
information about which error occurred and, most importantly, at what line number in 
which routine. This information cannot be provided during normal execution under 
Windows; you can, however, obtain similar information by running the debugger. To do 
this, you must first make several changes to your debug environment.

Go to Debug > Exceptions. A list of all possible exception conditions and what action can 
be taken if such a condition occurs displays. In most cases, you are looking for floating-
point exceptions, which start with the word “Float.” 

By default, such exceptions are handled by the MSC.EASY5 error handler. During a 
debug session, you do not want to use the error handler, so you can see at which point the 
error occurs. 

To do this, set all floating-point exceptions to an Action of Stop Always. Select each 
exception (hold <Shift> to select more than one exception), click Stop Always, and click 
[Change] and [OK]. You are ready to let you model terminate.

Once you have modified your exceptions, click [Go]. The debugger stops at any 
breakpoints you have set. Note that your model may be called many times until the 
termination error you are trying to find occurs. For this reason, you may want to 
temporarily disable all breakpoints and let the debugger run until any floating-point error 
occurs. When it does, the symbolic debugger stops at the line of code where the error 
occurred. 

If this line of code is in your model or an external source code routing you have provided 
and compiled in debug mode, you can see the line where the exception occurred. 
Otherwise, a Disassembly window is display. In this case, you can see the line number at 
which the debugger stopped in the Call Stack window. The Call Stack window is opened 
by default; if not, click the [Call Stack] debugger toggle button.
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Modifying a Variable

Something that can be quite useful in debugging your code is changing the value of a variable 
from the debugger (e.g., to force an alternate logic path). You can also do this with your 
pointing device; click and hold the variable name, and move it to the Watch window. You 
can change the value in this window. 

Disassembly View

Often, when you inadvertently step into a routine for which no debugging information 
exists, a Disassembly window is automatically displayed. This provides you a view of 
the assembly-level code. If you want to see step-by-step assembly code commands being 
processed, you can use this window, which can sometimes help. To return to the source 
window, select the Step Out function to leave the current routine. Click the 
[Disassembly] button to close the window and return to your source code window. 

Debugger Help

To get the most use out of your debugger tool, you should familiarize yourself with the 
resident debugger environment with its online help.   
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Environment variables are character strings used to associate a symbolic name with a 
particular value. MSC.EASY5 and other programs make extensive use of environment 
variables.

NOTE: MSC.EASY5 and Windows environment variables are defined and 
used differently. MSC.EASY5 environment variables are case sensi-
tive, and Windows variables are not, even though they may appear to 
be. When setting an environmental variable, do not use quotes (“ ”) 
around the value unless it contains white space, or spaces around the 
equal (=) sign. 

There are two basic types of environment variables: global and local. Global variables are 
available to all processes; they are variables comprising your standard environment, and local 
variables are only available to the specific process and all subprocesses that defined them. 

The method used to assign global variables, or to set your standard environment, differs 
between Windows 9x/Me and Windows NT/2K/XP operating systems; Windows NT/2K/XP 
has been designed to greatly simplify this.

Global Variables

There are different methods for modifying global variables, depending on your Windows 
version: 

Windows 2000/XP

Go to Start > Settings > Control Panel, double-click the System icon, and click the 
“Advanced” tab, followed by the “Environment Variables...” button.  You can assign 
either User or System variables.

Windows NT 4.0

 Go to Start > Settings > Control Panel, double-click the System icon, and click the 
Environment tab. You can assign either User or System variables, depending on your 
group permissions.

EN V I R O N M E N T  VA R I A B L E S

F O R  W I N D O W S 6
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Windows 98/Me

Edit file C:\AUTOEXEC.BAT and use the appropriate SET command. A reboot is 
required.

There are two important considerations for setting global environment variables, 
depending on your Windows operating system version:

• Windows NT/2000/XP:   Changes made to environment variables globally only 
affect new MS-DOS Command Prompt or EASY5 Command Shell windows. 
Existing ones will be unaffected.

• Windows 98/Me: Changes made to environment variables globally only go into 
effect after you reboot your computer. MSC.EASY5 does not use any global vari-
ables for Windows 98/Me; all environment variables are set as local variables from 
an EASY5 Command Shell environment via a batch file

 User and System Variables

Windows NT/2000/XP further classifies global environment variables into two kinds: 
System and User. System variables affect all users of your computer, while User 
variables affect only you. To set System variables, you must have Administrator group 
privileges.

Local Variables

Local variables are maintained in any MS-DOS Command (or EASY5 Command Shell) 
window. They do not affect your standard (global) environment variables, only processes 
launched from that window.

Setting a Variable

To set an environment variable, enter the following command:

SET var_name=value

Do not enter a blank character (space) before or after the value.

Deleting a Variable

To delete an environment variable, enter the following command:

SET var_name=
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MSC.EASY5 Environment Variables for Windows

The EASY5 Setup program sets all required environment variables in two files during the 
installation of MSC.EASY5 program files. 

• MSC.EASY5 environment variables are set by the batch file EZ5VARS.BAT, which 
is located in the MSC.EASY5 destination folder (path %EZHOME%). 

• MSC.EASY5 license-related environment variables are set by batch file 
EZ5LMVARS.BAT, which is located in the MSC.EASY5 license manager folder 
(path %EZLMDIR%). 

These batch files are started whenever an EASY5 Command Shell is created, or when 
MSC.EASY5 is launched from a shortcut. This means that MSC.EASY5 cannot be started 
from any MS-DOS Command Prompt window without first starting the batch file 
EZ5VARS.BAT (the batch file EZ5LMVARS.BAT is automatically started).

Several environment variables are used and set in your EASY5 Command Shell environment 
as shown in the following table. Other environment variables are also set in other 
MSC.EASY5 related background processes, but are not saved in the EASY5 Command Shell 
environment, so they are not listed. 

Of the variables listed in the table, PATH and LIB are the two most important, because they 
affect how a wide variety of programs run. During initialization of these environment 
variables, MSC.EASY5 appends the current standard environment values to its own required 
PATH and LIB settings.   Please see "Local Variables" for more information on viewing 
current environment variable settings from any EASY5 Command Shell environment.

If you are having problems running certain MSC.EASY5 programs, such as the error that 
they cannot be found, it is usually a problem of an incorrect PATH. 

For example, if you have modified the PATH or oPATH variable from an EASY5 Command 
Shell window, you may find that MSC.EASY5 will not work. If so, it is recommended that 
you close the window and open a new EASY5 Command Shell. 

NOTE: If you make any changes to the MSC.EASY5 batch initialization files 
(EZ5VARS.BAT or EZ5LMVARS.BAT), it is recommended that you first 
make a backup of the default versions of these files, because they 
control the majority of MSC.EASY5 environment settings.
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Name Value

ALT_EASY5_LICENSE Path to alternate MSC.EASY5 license file (optional)

EZAPPENDLIC License file to append to MSC.EASY5 license, taken from 
MSC_LICENSE_FILE at initialization

EZHOME MSC.EASY5 program file home path

EZLICSERVER Indicates which computer is designated as an MSC.EASY5 license server 
and has a hardware key attached

EZLMDIR MSC.EASY5 license manager utility folder

FOR_IGNORE_EXCEPTIONS true  for Compaq Fortran compiler only; enables FP error trapping

HOME Korn Shell path of MSC.EASY5 working folder

LIB %EZHOME%\System; CompilerPaths; %LIB%

MSC_LICENSE_FILE MSC license file specification

oLIB Previous value of LIB

oPATH Previous value of PATH

PATH %EZHOME%\Shell; %EZHOME%\System; %EZHOME%\;
<CompilerPaths>;<ExceedPath>;%oPATH%

ROOTDIR Korn Shell path of MSC.EASY5 Shell folder

SHELL Korn Shell path for shell executable

TK_NTSECURITYINFO_SID
_TERSE

true  (used to abbreviate SID information when entering a Korn Shell 
ls -l command)

TMPDIR Korn Shell path of temporary folder

USE_ALT_EASY5_LICENSE If true, MSC.EASY5 uses license specified by ALT_EASY5_LICENSE 
(optional)

WSLOGIN MSC.EASY5 working folder (user variable)

XNLSPATH %EZHOME%\ExceedUser  (X language definition file)

XKEYSYMDB %EZHOME%\ExceedUser\xkeysmdb  (X keyboard definition file)
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Optional MSC.EASY5 Environment Variables

Searching for a Particular Variable

To search for a particular variable named <find_me>, enter the following command:

SET | FINDSTR <find_me>

Viewing Variables

To view the values of all environment variables (one page at a time), enter the command:

SET | more

Referencing Variables

Environment variables are referenced by enclosing them in percent characters (%). For 
example, to move to your working directory, given by %WSLOGIN%, and display the 
value of your MSC.EASY5 home directory, given by %EZHOME%, you can enter the 
following commands from an  EASY5 Command Shell window:

cd /d %WSLOGIN%

echo %EZHOME%

Optional MSC.EASY5 Environment Variables

Environment variables are also used to modify various MSC.EASY5 settings. A list of 
available environment variables displays when you enter the command easy5x -vars at 
an EASY5 Command Shell prompt.

All MSC.EASY5 environment variables must use proper case (e.g., UPPER versus low-
er). 

To display the values of all currently set MSC.EASY5-related user environment variables, 
enter the command: 

easy5x -varset 

from an EASY5 Command Shell prompt.
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Group Privileges

             Group Privileges

Windows NT/2K/XP provides a multiuser environment with a high level of security. This 
means, however, that only certain users of your computer can perform certain operations. 
Administrator group privileges are required to make settings that affect other users of your 
computer or make changes to your system (which could also affect other users). 

Windows 2000/XP:  Identification of your group privileges is simple. Go to Start > Settings 

> Control Panel > Users and Passwords, find your User Name in the list -- the Group column 
should list what group privileges your account has been setup for. 

Please note that under Windows 2000/XP a minimum of  “Power Users” group 
privileges are required to install and update MSC.EASY5 on your computer.

Windows NT:  To see if you have administrator group privileges, follow the instructions for 
setting a Global environment variable (see "Global Variables"). If you can set System 
variables from here, you have Administrator group privileges. If not, your system 
administrator can use the NT User Manager to (re)assign reassign your group privileges. See 
your Windows NT/2K Workstation Help for more information.

Enabling the Korn Shell from an MS-DOS Command Prompt Window

By default, MSC.EASY5 is installed with Korn Shell commands only enabled from EASY5 
Command Shell windows.   To enable Korn Shell commands from any MS-DOS Command 
Prompt window, you must set the following environment variables globally in your standard 
environment. 

ROOTDIR Set to same value set in any EASY5 Command Shell

SHELL Set to same value set in any EASY5 Command Shell

TMPDIR Set to same value set in any EASY5 Command Shell

PATH Include full path to the EASY5 Shell folder first
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NOTE: Exceed version 5.1.3.3 or greater is required for compatibility with 
MSC.EASY5 version 5.3 and greater. For Windows 9x, MSC.EASY5 
requires Exceed 6.0+.   For Windows 2000, you need Exceed 
6.2.0.17+, for Windows XP, you need Exceed 7.1+.  If you do not 
currently have a compatible version, please consider purchasing a  
license permitting use of our OEM version of Exceed 8.0, or contact 
Hummingbird directly to obtain an update, or an evaluation copy. 

MSC.EASY5 is not a Windows operating system application; instead, it is an X Windows 
application, which uses an X server for display. Hummingbird Exceed is the selected X server 
software, but MSC.EASY5 windows are still managed by the Windows operating system 
(although this can be changed). When you start MSC.EASY5, you can see a Hummingbird 
logo displaying briefly on your monitor, followed by an Exceed task on the Taskbar. You can 
also launch Exceed directly from the Start menu.

OEM Version of Exceed 8.0

With MSC.EASY5 2004, we provide an OEM (non-eval) version of Hummingbird Exceed 
8.0 software with the MSC.EASY5 CD media.  This helps to simplify the tasks associated 
with installing this required third-party software.  Once installed, you should not have to 
worry about it again.  However, installation of the OEM version of Exceed will automatically 
trigger a requirement for an MSC.EASY5 license feature named “ExceedOEM” whenever 
MSC.EASY5 is started.

NOTE: Thus, if you already have a working (non-eval) version of Exceed, 
compatible with MSC.EASY5, you should not install this OEM 
version. 

The “ExceedOEM” license feature must be ordered, purchased, and obtained from 
MSC.Software just like any other MSC.EASY5 license feature.

EX C E E D  X SE R V E R

F O R  W I N D O W S  ON L Y 7
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Exceed Configuration Settings

An evaluation version of Hummingbird Exceed 8.0 is still available with our MSC.EASY5 
Demo software. The evaluation version of Exceed allows you 60 days of use from the 
installation date. However, please note that once installed, the evaluation software should be 
uninstalled before installing the OEM version of the Exceed software.

Later releases of Exceed are designed to work better with the more recent versions of 
Windows, like Windows XP.

Exceed Configuration Settings

NOTE: If you have installed Exceed from the MSC.EASY5 CD, all Exceed 
configuration settings have been preconfigured for optimal use for 
MSC.EASY5. 

Exceed configuration settings are a powerful means to control how MSC.EASY5 works and 
displays on your computer. If you are using Exceed for other applications, be careful that 
settings you make for other applications do not negatively impact your MSC.EASY5 
environment, and vice versa. Exceed configuration settings are managed by the Xconfig 
program. Settings are stored in the Exceed User directory as file exceed.cfg.

Launching the Exceed Configuration Program

You can access the Exceed configuration settings by CLICK-R the Exceed Task on the 
Taskbar and selecting Tools > Configuration. Alternatively, select the application 
Xconfig from the Start Menu (under Programs > Hummingbird Connectivity  V8.0 > 

Exceed.   This launches Xconfig, the Exceed configuration program. You can use this 
program to view and modify your Exceed configuration settings. 

Recommended Default Exceed Settings for MSC.EASY5

NOTE: If you installed Exceed from the MSC.EASY5 CD per defaults, all 
Exceed configuration settings have been preconfigured for optimal use 
with MSC.EASY5. 

Warning - without the correct Exceed configuration settings, MSC.EASY5 
may not be properly enabled.   Please follow these instructions to avoid such 
problems.
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Recommended Default Exceed Settings for MSC.EASY5

It is strongly recommended to start with the default settings throughout and then ensure that 
the following settings are correct:

Exceed 5/6/7/8

Input
Middle Button Emulation = YES (if your mouse is a two-button mouse)

Communication
Mode = Passive (enables local clients like MSC.EASY5)

Window Mode
Close Warning on Exit = NO
Cascade Windows = NO
Focus Policy = Click

X Selection
Auto Copy X Selection = NO
Auto Paste to X Selection = NO

Performance
Save Unders = YES
Maximum Backing Store = When Mapped
Default Backing Store = When Mapped
Minimum Backing Store = When Mapped

Exceed 6.x, Exceed 7.x, Exceed 8.x, Exceed 9.0

(Keyboard) Input
Middle Button Emulation = YES(if your mouse is a two-

button mouse)

Communication
Mode = Passive(enables local X clients like MSC.EASY5)

Screen Definition

Common Settings (Tab)

Close Warning on Exit = NO
Focus Policy = Click

Screen 0 (Tab)
Cascade Windows = NO
Window Mode = Multiple
Window Manager = Native

Performance
Save Unders = YES
Maximum Backing Store = When Mapped
Default Backing Store = When Mapped
Minimum Backing Store = When Mapped
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Updating Exceed Transport DLLs (for Exceed 5.x/6.x only)

Updating Exceed Transport DLLs (for Exceed 5.x/6.x only)

NOTE: This section only applies if you are using Exceed versions 5.x or 6.x.

Starting with MSC.EASY5 version 5.3.2.1, MSC.EASY5 automatically updates required 
communication files, called transport DLLs, stored in both the MSC.EASY5 system and 
Exceed program directories. This step is not performed if you have Exceed 7.0+. Updating 
these files is required if the version of Exceed is lower than the version of Exceed libraries 
used by MSC.EASY5 (namely, Exceed 6.2), to ensure that the latest version is used in both 
MSC.EASY5 and Exceed. 

The following five transport DLL files, stored in the MSC.EASY5 system folder, are 100% 
backwards-compatible for any version of Exceed 5/6 and are only copied to the Exceed 
program directory as needed:

hcllocal.dll
hclxport.dll
wxlport.dll
wxport.dll
lxport.dll

NOTE: Backup versions of these files, which can be identified by the .bak tag, 
are automatically created by EASY5 Setup. The default Exceed 5/6 
program folder is C:\Program Files\Exceed[.nt].

If a version of Exceed 5/6 is reinstalled  after MSC.EASY5 has been installed, these files 
are overwritten with the out-of-date versions. These older files may be incompatible with 
the transport DLLs used by MSC.EASY5, possibly causing some serious errors to occur.

To restore the required version of these files in the Exceed program directory from a 
particular MSC.EASY5 installation, go to Start > Programs > MSC.Software>MSC.EASY5 

2004 > Utilities > Restore System Settings. This restores all system settings, shortcuts, and 
transport DLL files without requiring a complete reinstallation of MSC.EASY5. 

NOTE: If you cannot perform this operation using EASY5 Setup, you must do 
it manually by using two Windows Explorer  windows. 
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License Management for Unix

Please refer to the "Flexible License Manager" section in your MSC.EASY5 Unix Install 
Notes. 

License Management for Windows

MSC.EASY5 is license managed using FLEXlm software from Globetrotter. License 
management provides an adequate level of security with a maximum of flexibility. How and 
where the license management software is installed and administered depends on the type of 
license. Two types of MSC.EASY5 licenses are available for use with Windows:

• Node-Locked: Limits use of MSC.EASY5 to the computer with the hard-
ware key, or a specific MAC Address.

• Concurrent/Campus: Limits the number of MSC.EASY5 users or tokens that can 
be running simultaneously across a network.

See the appropriate section below for details of license management for these types of 
licenses.

Node-Locked License

With a node-locked license, each license of MSC.EASY5 is used to run MSC.EASY5 on 
a given computer. However, the number of MSC.EASY5 applications running at any 
given moment is not limited, as long as it runs on the computer with the correct hostid. 
Depending on the installation there are two possibilities for hostid:

• MAC Address (network ethernet card) serial number.

• Hardware key (dongle).

Even though the MAC Address serial number eliminates the need for a hardware key and 
installation of associated Sentinel drivers, it allows you less flexibility because it ties 
MSC.EASY5 to a single computer. Please see your Windows Install Notes, "MAC 
Address (Ethernet Card) Serial Number" for more details.

L I C E N S E  MA N A G E M E N T 8
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License Management for Windows

A hardware key provides additional flexibility because it locks a particular license to the 
hardware key, not to a particular computer. Therefore, even though you can install 
MSC.EASY5 on multiple platforms with a single hardware key and license, you can only 
execute MSC.EASY5 on a given workstation when the appropriate hardware key is 
connected.

You can share one hardware key among several computers, as long as no two users need 
to use MSC.EASY5 at the same time. Sentinel driver software is installed in Windows 
system directories, allowing the hardware key to be properly read. Please see your 
Windows Install Notes, "Hardware Key" for more information

Once driver software is installed, an automatic service is started. Administrator privileges 
are required.

Concurrent/Campus License

A concurrent license limits the maximum number of simultaneous users (or tokens) of a 
given license feature within a given site. Typically, an MSC license server is installed on 
a network server to administer the licenses within a local area network. The 
MSC.EASY5 program files are then either loaded on individual computers or only on the 
network server (to be accessed by multiple MSC.EASY5 client installations). This 
greatly increases the flexibility of a given license but requires additional effort to install 
and maintain the license server. However, it also provides the possibility for more 
simplified, centralized system administration.

 MSC.Licensing Software

When installed on a Windows NT/2K/XP–based PC, this software installs a service, 
which automatically launches two processes (lmgrd.exe and msc.exe) on the 
license server computer. These processes continuously administer the concurrent 
license using network TCP/IP-based communication. Once started, the MSC 
License Server service runs automatically and is restarted every time the computer 
is rebooted. 

When you install an license server service, another folder is created on your 
workstation. The folder is located in path C:\FLEXLM and contains certain FLEXlm 
license management–related log files. For the most part, you can ignore these files, 
but it is important that you do not delete this folder.
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Unix-Based Remote License Server

You can also separately install and maintain a concurrent license on a Unix server. 
Note that installation of a Unix-based license server is typically performed by a Unix 
system administrator and is not discussed here. Nevertheless, this option means that 
a Windows user can access an existing Unix-based MSC.EASY5 license server by 
simply linking to the existing Unix license file with the environment variable 
MSC_LICENSE_FILE or ALT_EASY5_LICENSE. See your Windows Install Notes 
"Remote UNIX-Based License Server" for more information.

License File

MSC.EASY5 uses license management software by Globetrotter called FLEXlm 
(version 9.2). Starting with MSC.EASY5 2004, an environmental variable 
MSC_LICENSE_FILE links to the full path of the license file to ensure that no conflicts 
exist when trying to run more than one FLEXlm-based application on your computer 
(previous versions of MSC.EASY5 or other FLEXlm-license managed applications can 
use another environment variable LM_LICENSE_FILE). MSC.EASY5 executes a 
batch file EZ5LMVARS.BAT to initialize its license-related environment variables 
whenever you open MSC.EASY5 from a shortcut or open an EASY5 Command Shell 
window. When updating license files, you must also go to Start > MSC.EASY5 2004 > 

License > License Update to update the license-related MSC.EASY5 batch file (file 
%EZLMDIR%\EZ5LMVARS.BAT).

Accessing an Alternate License File

In some instances, it can be useful to switch between two license files. For example, 
if you have a laptop computer, you may want to alternate between use of a 
concurrent license and a node-locked license. In this way you can minimize the 
number of licenses required while connected to the network, yet use a single 
transferable, node-locked license when traveling. Recognizing this need, a method 
for easily switching between two license files is provided using the following two 
environment variables:

When USE_ALT_EASY5_LICENSE=true, MSC.EASY5 uses the alternate 
license file specified by ALT_EASY5_LICENSE. Otherwise, it uses the default 
license file. 
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In this situation, first install MSC.EASY5 with the default, preferably node-locked, 
license. Then, specify the alternate license file by setting the variable 
ALT_EASY5_LICENSE to the alternate license file path, and the variable 
USE_ALT_EASY5_LICENSE   to false. Then, when using the alternate license 
file, set the latter to a value of true. 

Using Multiple or Concatenated License Files

In rare cases, it may be necessary to concatenate the environment variable 
MSC_LICENSE_FILE with the value of more than one MSC.EASY5 license file. 
For example, this could occur if you wanted to access two MSC.EASY5 license files 
at the same time. The environment variable can be concatenated, that is, multiple 
paths can be specified using a semicolon (;) as a delimiter. 

However, because of the way MSC.EASY5 sets this environment variable in its own 
local environment, a provision must be made to allow for this concatenation. You 
can accomplish this by setting the global environment variable 
MSC_LICENSE_FILE. 

When MSC.EASY5 detects this variable when starting, it appends it to its default or 
alternate license file path and includes a delimiter. It uses the local environment 
variable EZAPPENDLIC to store the appended license file path. 

Alternately, you can also edit the batch file %EZLMDIR%\EZ5LMVARS.BAT and 
modify the value of EZDEFLIC to include more than one file path, each separated by 
a semicolon (“;”) delimiter Please see section "Global Variables" on page 41 for 
details on assigning a global environment variable. 

Checking License File Data

To display information contained in your license file, enter the command: easy5x 
-lic from any EASY5 Command Shell, from the shortcut Start > MSC.EASY5 2004 

> License > License Status, or by selecting the Licensed Features... Help menu item 
from the MSC.EASY5 user interface.

Checking License Manager Status

The most clear indication of a license problem is if you simply cannot execute 
MSC.EASY5, and an error dialog is given with a log file. In addition, an error 
message may be seen in your EASY5 Background Shell or EASY5 Command Shell 
window. 
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To obtain more information or to verify that your license manager is working 
properly, enter the command easy5x -lmstat from any EASY5 Command Shell, 
go to Start > Programs > MSC.Software>MSC.EASY5 2004 > License > License 

Manager Status, or by selecting the Help > Licensed Features... menu item a from the 
MSC.EASY5 user interface. 

If you have a concurrent license, the LMUTIL program is started to check the status 
of the MSC license server. 

License Management and the System Date

MSC.EASY5 uses FLEXlm license management software that, under Windows, is very 
sensitive to system date modifications. This helps prevent certain modes of software 
piracy. If FLEXlm detects any system file with a date after the current system date, any 
MSC.EASY5 license is invalidated. It is strongly recommended that you do not change 
your system date after you have installed MSC.EASY5. If you inadvertently modify your 
system date and MSC.EASY5 no longer works, see the section "Troubleshooting and 
Workarounds" on page 73 for more information.

Uninstalling the Sentinel Driver in Windows

Normally, this driver is uninstalled automatically when MSC.EASY5 in uninstalled. 
Please see your Windows Install Notes section "Manually Uninstalling the Sentinel 
Driver" for information on manually uninstalling the Sentinel drivers. 

 License Server Tools 

License Server Tools, provided by Macrovision., are installed as part of the 
MSC.Licensing software and are applicable only for concurrent licenses. Access these 
tools by selecting the appropriate MSC.Licensing shortcut. 

Updating Your License

One of the most commonly performed license management tasks is updating your 
MSC.EASY5 license. Typically, this is required at least once a year for security 
purposes. Each time you execute MSC.EASY5 you are informed how many days are left 
in your license. 

This information displays in your EASY5 Background Shell or EASY5 Command Shell. 
You should be contacted before your license expiration date for arrangements and 
instructions for updating your license. If not, please contact MSC.EASY5 Support.
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NOTE: If you want to use an existing Unix-based license, see the section 
"Remote UNIX-Based License Server" in the Windows Install Notes for 
more information.

You receive a new license file to update your MSC.EASY5 license. License files, 
typically named MSC.LIC (or license.dat), are sent by e-mail or floppy disk with 
instructions. If you received the license file by e-mail, save it on your hard disk in a 
separate folder (preferably c:\license). 

Do not overwrite the existing license file, located in the MSC.EASY5 lmgr  folder. The 
installation program does this for you. With this file in hand, perform the following steps:

1 Start the license update process. For node-locked or previously installed concurrent 
licenses go to Start > Programs > MSC.Software>MSC.EASY5 2004 > License > 

License Update. To install an updated concurrent license use the appropriate 
MSC.Licensing shortcut, and follow the email instructions provided with your 
license file provided by MSC.

2 Once you have started the proper license update, you are prompted to specify the 
license file. Once the license file is submitted, Setup installs the license file and 
performs the required installation operations.

3 Restart your computer. Setup informs you if this is necessary.

4 Confirm your license update. Go to Start > Programs > MSC.Software>MSC.EASY5 

2004 > License > License Manager Status.   Updating the license server license only 
updates the license used with the License Server installation. If MSC.EASY5 is 
already using this same concurrent license, you have finished updating the license. 
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MSC.EASY5 has established links to other computer-aided engineering (CAE) software pack-
ages. This allows you to use the advantages of other tools by using them in tandem with 
MSC.EASY5. These links either allow you to embed the other package model within 
MSC.EASY5 or vice versa. Instructions for using these links or other tools vary depending on 
the package in question; see the appropriate following sections. At present, MSC.EASY5 pro-
vides links to the following software packages, and others are in progress:

MSC.ADAMS®

This link has been implemented as an extension to MSC.EASY5. The extension behaves like 
any other MSC.EASY5 component, yet provides a direct link to an MSC.ADAMS model. 
With this implementation, MSC.EASY5 actually links in all equations from the 
MSC.ADAMS/Controls model into your MSC.EASY5 model, where all numerical 
integration can be centrally solved. You must have a license for MSC.ADAMS/Controls to 
use this capability (contact MSC.Software Corporation directly to obtain a license). In 
addition, the documentation for MSC.ADAMS/Controls contains important instructions for 
installing and using the link between MSC.EASY5 and MSC.ADAMS. Contact your system 
administrator or MSC.Software for these instructions.

DADS®

This link has been implemented as an extension to MSC.EASY5. The extension behaves like 
any other MSC.EASY5 component, yet provides a direct link to a DADS model. With this 
implementation, MSC.EASY5 actually links in all equations from the DADS model into your 
MSC.EASY5 model, where all numerical integration is solved centrally. You must have a 
license for DADS and DADS/Plant to use this capability (contact CADSI directly to obtain a 
license).

Product Vendor Typical application

MSC.ADAMS MSC.Software Mechanism analysis

DADS LM-CADSI Mechanism analysis

Pro-Mechanica Motion Parametric Technologies Mechanism analysis

MATLAB/Simulink MathWorks, Inc. Control systems

L I N K S  T O  OT H E R  CAE TO O L S 9



58         MSC.EASY5 2004        

LINKS TO OTHER CAE TOOLS

Pro-Mechanica Motion®

In addition, the documentation for DADS/Plant contains important instructions for installing 
and using the link between MSC.EASY5 and DADS. Contact your system administrator or 
CADSI for these instructions. See also section "Troubleshooting and Workarounds" on page 
73 for information on circumventing a known installation problem between MSC.EASY5 
and DADS.

Pro-Mechanica Motion®

This link requires a license for Pro-Mechanica Motion and is implemented with an 
MSC.EASY5 user-defined macro or Fortran component. This MSC.EASY5 component is 
used to make required calls to existing Pro-Mechanica/Motion code. Contract Parametric 
Technologies for documentation on creating this link.

MATLAB/Simulink

These links require an MSC.EASY5 license for MATLAB interface, as appropriate, as well 
as the MATLAB/Simulink components. Installation of this interface software is done with 
the MSC.EASY5 installation CD and enables you to embed MSC.EASY5 models within 
MATLAB. Please see your EASY5 Guide for more information (“MATLAB Interface User 
Guide”) or contact your MSC.EASY5 sales representative about obtaining a MATLAB 
interface license for MSC.EASY5.
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Multiple MSC.EASY5 Executions

It is not recommended that you run multiple copies of MSC.EASY5 on your computer at the 
same time unless you follow certain guidelines. Outside of concurrent license restrictions, no 
problem exists if you are careful about starting MSC.EASY5 from the correct folder and 
about navigating and opening model files from within MSC.EASY5. 

MSC.EASY5 uses many temporary files that may inadvertently get modified or overwritten 
by another parallel MSC.EASY5 background process. In addition, these files may potentially 
be locked by competing processes. Because the temporary files exist only in the local 
MSC.EASY5 working folder (from where you launch MSC.EASY5 or where your model 
file resides), you must avoid such collisions. This means that you must launch MSC.EASY5 
from separate working folders and ensure that models being worked on or running are not in 
the same folder.

To run multiple MSC.EASY5 processes at the same time, use the following steps:

1 Start a new EASY5 Command Shell from the Start Menu.

2 Move to a separate folder for each instance of MSC.EASY5 that you are running. Use the 
cd command to move around.

3 Launch MSC.EASY5 with the command:  easy5x <model_name>

4 Avoid navigating between folders from within MSC.EASY5, so that you are less likely to 
find yourself in the same working folder as the other MSC.EASY5 processes that may be 
running.

Program and Library Versions

You can determine MSC.EASY5 program and component library versions by going to Start 

> Programs > MSC.Software > MSC.EASY5 2004 > Help > About. You can also access this 
information from any EASY5 Command Shell window by entering the command easy5x -
version.The current version of the MSC.EASY5 program and all installed component 
libraries displays.

T I P S  F O R  W I N D O W S  US E R S 1 0
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MSC.EASY5 Site ID

MSC.EASY5 Site ID

To help MSC.EASY5 support staff serve you faster and more efficiently when you call 
MSC.EASY5 Support, a site identification code called the MSC.EASY5 site ID is now being 
used. This ID allows MSC.EASY5 to rapidly find your information in online databases and 
provide cross-referencing between customer and company data. This allows MSC.EASY5 
staff to respond to your questions in a timelier manner. To obtain the site ID, enter the 
command easy5x -site at an EASY5 Command Shell window or go to Options > About 

from your main MSC.EASY5 window.

Display Settings

To adequately display the MSC.EASY5 graphical interface, a minimum 1,024 by 768 pixels 
graphic resolution is recommended. Most monitors providing better than VGA resolution are 
capable of this; if not, you may need to find a higher resolution monitor. Depending on your 
monitor, video board, and video memory, you have different display options. Go to Start > 

Settings > Control Panel and double-click the Display icon to modify the display settings.

Getting the Most out of Your Desktop Area

The following tips can help you use your desktop area more efficiently:

• Task Bar: If window space is a problem, you may consider setting the Task Bar to 
Auto Hide mode. To do this, right-click the Task Bar, select Properties, and choose 
Auto Hide.

• Other task bars: If window space is still a problem, you may also consider disabling 
other task bars, such as the Microsoft Office task bar. You can still place frequently 
used programs on the Desktop or in the Start Menu.
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Transferring ASCII (Text) Files Between Unix and Windows

NOTE: American Standard Code Information Interchange (ASCII) files are text 
files.

MSC.EASY5-generated text files created on Unix systems are compatible with your 
Windows–based computer, and vice versa. However, an important difference between the 
way ASCII files are encoded on these two systems exists.

A new line is coded differently on each of these systems. On Unix, a new line is represented 
by one ASCII character (a linefeed) and on Windows by two ASCII characters (carriage 
return and linefeed). When transferring files in ASCII mode between Unix and Windows 
(and vice versa), most FTP programs automatically convert the new line character as 
appropriate for the target system. 

However, if ASCII file-transfer mode is not used, ASCII files can be transferred without the 
conversion, causing problems when they are read and interpreted. Binary files are not 
compatible between Unix and Windows systems. Always make sure that all MSC.EASY5 
ASCII (text) files are transferred in ASCII mode between Unix and Windows systems.

 MSC.EASY5 Model Files

MSC.EASY5 model files are actually a special class of ASCII files. As ASCII files, once 
transferred from Unix, they contain Windows carriage-control characters. MSC.EASY5 
can automatically read a model file, regardless which carriage-control characters are 
used. However, when MSC.EASY5 creates a new model file or updates an existing one, 
it is written in binary mode, using only linefeed characters as carriage control delimiters. 
Because MSC.EASY5 can read the model file with either carriage control character set, 
you can safely transfer metafiles to other Windows or Unix systems without requiring 
any special conversions. 

Once saved by MSC.EASY5, MSC.EASY5 model files cannot be edited using any text 
editor that relies on Windows-specific carriage-control characters, such as Notepad. 
However, this should not pose problems because editing MSC.EASY5 model files, 
except as directed by MSC.EASY5 Support, is strongly discouraged. Nevertheless, by 
performing any edit operation and saving the file, the model file is automatically 
converted to Windows ASCII mode. You can also check and convert a metafile as shown 
in the following section. 
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Converting and Checking ASCII (Text) Files

If conversion of ASCII (text) files is required, several useful shell programs, flip and od, 
are provided and described in the following sections.

Converting an ASCII file to Windows form

To convert a file named file_name  from Unix to Windows ASCII form, use the 
command syntax:

 flip -d file_name.

Converting an ASCII file to Unix form

To convert a file named file_name  from Windows to Unix ASCII form, use the 
command syntax:

 flip -u file_name.

To Check an ASCII File

It is recommended that you use the od (octal dump) MSC.EASY5 shell program to check 
an ASCII file for carriage-control character type. This quickly evaluates whether a given 
file has Windows or Unix carriage-control characters in it. For example, you can use the 
command syntax combination

od -c file_name | tail -2 

to examine the contents of the last two lines of a given file for  \r\n  combinations. If 
none exist, then the file is in Unix ASCII mode.

NOTE: Only ASCII files that should ever be in Unix mode on your computer are 
MSC.EASY5 model files. Other files should be converted as previously 
shown.
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MSC.EASY5 7.0+ contains several new features affecting model and libraries.  These 
enhancements required modifications to the internal format of model and library-specific 
files. In addition, all file tags were renamed to conform to a more consistent, and unique file 
naming convention. In most cases, MSC.EASY5 automates conversion tasks, allowing you 
to simply open an existing model file, and convert it, and all related model-specific files, and 
local libraries automatically.

Nevertheless, the first task that existing EASY5 users will face is one of upgrading existing 
models and libraries to MSC.EASY5 7.0+ format. We recommend first converting existing 
macro libraries, then existing models.

Library Conversion

As an experienced EASY5 user, you are most likely familiar with the process of updating a 
given model with an updated library:  First, the updated library is installed, and then the 
existing models are updated on a component by component basis as they are opened. This is 
an automated process that makes it very simple to automatically update existing models with 
updated application libraries. 

Fortunately, all MSC.EASY5 application libraries have already been converted to V7 format, 
and are provided to you with your installation media.

Existing V6 Macro Libraries

NOTE: Existing V6 Macro Libraries must be converted to V7 format before 
they can be used by MSC.EASY5 7.0+. This task should be performed 
by the person responsible for the given macro library.

If existing V6 macro libraries are being used they will need to be updated to V7 
MSC.EASY5 format, before they can be made available to MSC.EASY5 7.0+. This is 
an operation that should be performed by the person responsible for the specific macro 
library -- typically, the macro library designer or macro library administrator. 

CO N V E R T I N G  MSC.EASY5 V6 
MO D E L S  T O  V7.0+ 1 1
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V6 macro libraries are stored using the following file names:  <lib>.dc.0, <lib>.df.0, 
and <lib>.ascii, where <lib> is the two-character library tag.  V7 macro libraries have 
a new internal format, allowing them to offer many new features, some of which you will 
see in MSC.EASY5 V7.0, and some for future use.  They also follow the new file tag 
naming convention with file names:  <lib>.ezdc, <lib>.ezdf, and <lib>.ezda.  

Macro libraries are typically stored in “local” directories, or in site-accessible directories 
using MSC.EASY5 environment variables, such as EASY5_SITE_LIB, 
EASY5_GROUP_LIB, or EASY5_USER_LIB.  Because they may continue to be used 
by V6 EASY5 users, conversion of an existing V6 macro library should have no impact 
on the V6 version of the macro library; it will simply be read and converted to new V7 
filenames in the same directory.

For detailed information on MSC.EASY5 file naming conventions, refer to "Model 
Files" and "Analysis Files" in Chapter 12, Model and Data Management in the 
MSC.EASY5 User Guide.

Library Restrictions

To conform to the new input/output naming convention, macro libraries now utilize “port 
names” instead of  “port numbers”.  Port names may be alphanumeric strings of up to 12 
characters long -- no other special characters or blanks are permitted.  A similar 
restriction -- only alphanumeric characters -- is now in place for the input/output name 
(physical quantity name).  If any blanks or underscore characters are detected, they are 
automatically stripped by the library converter, prefaced by a warning message. 

Underscore characters (“_”) in particular, have special meaning in MSC.EASY5, as they 
are used to delimit the input/output name between its various components.  If your 
existing V6 macro library does not use port names, something first made available in 
version 6.1 of MSC.EASY5 for display purposes only, the library converter will 
automatically assign the port name equal to the port number.
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Library Conversion Methods

Three methods are available for converting a macro library, and are discussed below:

1 When converting a V6 model from the Model Open dialog.  If local V6 macro 
libraries are detected, and no V7 version of them is detected, you will be prompted 
to convert all local V6 libraries before proceeding with converting the model.  
Editable libraries are libraries that are in your local working directory, or defined by 
the EASY5_USER_LIB environment variable.  The latter will require navigating to 
this directory path to perform a library conversion in that directory.

2 From the Macro > Convert Library > From V6 Library... menu item.  You can select 
one or more local V6 libraries from this dialog.

3 From an MSC.EASY5 command-line option.  This can be used only for a single 
library at a time.  From any EASY5 Command Shell environment, simply enter the 
following command:

easy5x -LibConvert xx where:  xx = library tag

In all library conversion methods, the library is converted via a MSC.EASY5 
background operation, with messages written to a log file. When invoked from within 
MSC.EASY5 this log file is automatically displayed for review. Pay particular attention 
to warning or error messages. An example library conversion log file is shown below:

Figure 1: Library Conversion Log File
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Model Conversion

Once all macro libraries have been successfully converted, you can begin conversion of 
model files. Pre-version 7.0 model files are identified by an internal version number, as well 
as by their external naming construct, <modelname>.mf.<v>.  MSC.EASY5 allows you to 
read older models of this type, but will immediately save them using the current V7 format 
and file naming construct, <modelname>.<v>.ezmf.  Data files, specifically input data files 
used to store analysis settings, operating points, temporary settings, etc., are called model-
specific data files, because they apply to a given model named <modelname>, and follow a 
similar naming convention, <modelname>.<ID>.<tag>.  When you copy or save a model to 
another directory, you would normally want to save such model-specific data files as well.  
During conversion, all model-specific data files are also converted to V7 format (internally, 
and externally -- using new file tags) and stored in the current directory.

For detailed information on MSC.EASY5 file naming conventions, refer to "Model Files" 
and "Analysis Files" in Chapter 12, Model and Data Management in the MSC.EASY5 User 
Guide.

Automatic Backup of Existing V6 Model Files

Existing V6 model (and related model-specific data files) are retained after the 
conversion.  However, to prevent them from cluttering up your directory they are 
automatically moved to a new sub-directory named “V6_Models”.  This means, that 
these files are still available to be run using a pre-V7 version of EASY5, if needed. When 
you find that you no longer need the older V6 files, you can seek out and delete such 
temporary “V6_Models” subdirectories.

There are three methods for converting V6 models, discussed in the following sections:

1 By opening a single model from the Open Model dialog.  See "Model Conversion 
via the Model Open Dialog" on page 67 for details.

2 From an MSC.EASY5 command line option, on a per-model basis.  See "Model 
Conversion via the Command-Line" on page 69 for details.

3 From the File > Model Management > Convert menu, to handle multiple models.  See 
"Model Conversion from the Model Management Menu" on page 70 for details.
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Model Conversion via the Model Open Dialog

This method works by converting one model at a time in a given directory, and is best 
when converting only a handful of models.  To convert multiple models in a given 
directory, please refer to  "Model Conversion via the Command-Line" on page 69 or 
"Model Conversion from the Model Management Menu" on page 70.

Identification of a V6 Model in the Model Open Dialog

To open a model use the File > Open... menu item.  MSC.EASY5 detects existing V6 
models in the Model Open dialog, and marks each one using an asterisk (“*”), as 
shown below: 

If any V6 models are detected in a given directory, the phrase “(* = needs 
conversion)” appears after the “Model Names” dialog heading.  To convert a V6 
model simply select it, and select the [Open] button.

Model Conversion of a Single Model

Once a V6 model is opened, MSC.EASY5 provides the following dialog, allowing 
you the ability to proceed or cancel. If you proceed, MSC.EASY5 performs the 
following steps:

1 MSC.EASY5 checks for 
any local libraries that 
have not yet been 
converted.  If any local 
libraries exist, they 
should be converted 
before any models that 
use components from 
these libraries.  See 
"Existing V6 Macro 
Libraries" on page 63 for 
more information.

2 Model files will be 
opened, converted, and 
saved using V7 formats.

3 Related model-specific 
data files will be 
converted and saved.  

Figure 2: File Conversion Message Dialog 
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MSC.EASY5 automatically renames input/output names referred in analysis 
settings files to conform to the new MSC.EASY5 7.0 naming conventions.  You can 
check the Message Log to verify this.

4 All V6 versions of this model and related data files, such as .si, .tv, and so on, 
will be moved to subdirectory "V6_Models" to avoid clutter.

5 Any V6 model-related output files, such as .rpd, .apl, and so on, will also be 
moved to the subdirectory "V6_Models".

6 Any V6 MAT script files will be converted and saved, and V6 versions moved to 
sub-directory "V6_Models.

7 If necessary, all components will be synchronized with currently active libraries, 
per your approval.  (This step is no different from any version of MSC.EASY5).

Once you select OK, these conversion steps are performed, and if successful, the 
model should appear in the schematic, but will require resynchronization with the 
currently active set of libraries. 

A Model/Library Configuration Notifications dialog, as shown below (excerpted) is 
typical (for any version of MSC.EASY5):

Figure 3: Model Library Configuration Notifications Dialog 
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Once you have successfully converted a V6 model and saved it, it will no longer be 
marked with an asterisk (“*”) in the Model Open dialog, and you will see a new 
subdirectory named V6_Models containing the V6 model and related files. 

The conversion operation is normally a one-time process, although it can be 
repeated, if necessary, by navigating to the V6_Models subdirectory and repeating 
the operation.  Another V6_Models subdirectory is created in the process to store the 
original V6 files.

Model Conversion via the Command-Line

Models can also be converted without any prompts from V6 to V7 format by entering the 
following command from any EASY5 Command Shell prompt:

easy5x -AutoUpdate <modelname>

Please see "Model Conversion via the Model Open Dialog" on page 67 for the steps 
performed during a model conversion. The only step that is not performed using this 
approach, is there is no local library conversion as described in the section "Library 
Conversion Methods" on page 65. The prior V6 model and related files are all moved to 
a subdirectory named “V6_Models”.

Figure 1: Open Model Dialog with New Subdirectory
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Model Conversion from the Model Management Menu

The previous methods work by converting one model at a time. These methods are useful 
to convert models as you need them. However, if you have many models in a local 
working directory that need to be converted there is another method available. 

To use this method, navigate to the appropriate working directory, using File -> Open... 
and open any model (Untitled, if necessary) in the directory containing multiple V6 
model files. Select the File > Model Management > Convert menu item. A dialog similar 
to the one shown below appears.

From this dialog, you can select multiple models to be converted. Once the models are 
selected, select the [OK] button to start the conversion process. 

Figure 5: Open Model Dialog with New Subdirectory
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Before proceeding with the 
conversion, MSC.EASY5 
displays the following 
confirmation dialog, describing 
each step of the conversion 
process. The only difference is 
that local macro libraries are not 
checked for conversion, as they 
are per "Model Conversion via 
the Model Open Dialog". To 
proceed, select [OK].

The conversion occurs as a 
background operation, and the 
results are reported both in the 
status line and by a log file 
displayed after the operation is 
complete, similar to that shown 
below.

Figure 6: Confirmation Dialog 

Figure 7: Conversion Log 
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Troubleshooting

EASY5 Setup detected certain Exceed system files in my Windows system folder, and 
recommended that these files be deleted.  Which files should be deleted?
The following list of Exceed system files should not be found in your Windows system 
folder:  hclice.dll, hcllocal.dll, hclshm.dll, hclt.dll, hclwprod.dll, hclwutil.dll, hclxpmon.dll, 
hclxport.dll, hclxport.dll, hclxt.dll, localcon.exe, lxport.dll, wlxport.dll, wxport.dll, and 
Xlib.dll. These files may have been inadvertently copied here with an earlier installation of 
EASY5 6.0.2. These files should be manually deleted if they are located in your Windows 
system folder. EASY5 Setup will prompt you to perform this step during installation of 
program files, or if the “Reinstall System Settings” Start Menu shortcut is selected.

When using Exceed 7.0/8.0 I notice that I have to sometimes keep moving my mouse 
back and forth to keep the simulation utilizing IS widgets running. What can I do to 
remedy this?
This is indicative of a problem with an Exceed runtime DLL, specifically file HclXt.dll. This 
problem was corrected with the DLL version 7.0.0.1 or higher. EASY5 6.0.4+ installs this 
version of the DLL in the EASY5 “System” folder, and for Exceed XDK or Exceed 3D it will 
try to update the resident version of this DLL in the Exceed program directory. If EASY5 
Setup is unsuccessful in this effort, you should manually verify that version 7.0.0.1 or higher 
is in place in the Exceed program directory (only if the file is there).  A similar file is needed 
for Exceed 8.0 (file HclXt.dll, version 8.0.0.1).

I am using MSC.EASY5 under Windows 2000/XP and I note that sometimes the 
background window pops to the foreground, and the Exceed and MSC.EASY5 icons on 
the Task Bar are flashing and darker.
This is another known problem under Windows 2000/XP, which occurs pretty consistently if 
Exceed is already up and running when you invoke MSC.EASY5. Other applications have 
experienced similar problems with Windows 2000. This is due to a change made in Windows 
2000 affecting how foreground applications obtain “focus”. EASY5 Setup now provides the 
opportunity to correct this behavior -- you simply need to answer Yes to the associated dialog/
prompt given. If you select No, the default Windows setting will be used. Please note that you 
can change this setting simply by performing a Per-User Setup.

TR O U B L E S H O O T I N G  A N D

WO R K A R O U N D S 1 2
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Troubleshooting

I can’t get the Search button to work with the EASY5 Guide -- nothing happens when 
I click on it.
Make sure that you have installed version 4.05+ of Acrobat Reader. Earlier versions do not 
support the Acrobat Reader search capability. Version 4.05 of Acrobat Reader is available 
either from Adobe at www.adobe.com, or directly from the MSC.EASY5 Installation CD.

I can’t seem to be able to utilize a concurrent license using the “port@host” method, 
even though I have a TCP/IP connection established -- a WinSock error is reported in 
the resulting error message. 
Even though you are able to communicate with a particular network host (say, via a “ping 
host” command), the host also needs to be found by your internet domain name server 
(DNS). In this case it is likely not registered as it may be outside your local domain. 

To add a particular host to your computer, you can edit your “hosts” file (Windows NT/2K/
XP:  see%WINDIR%\system32\drivers\etc.  For Windows 9x/Me, see folder 
%WINDIR%. A hosts.sam file is provided as a sample.

I am using the Matlab Interface and when it gets executed (under Matlab) it crashes 
MATLAB.
Please verify that you do not have any Fortran WRITE (or PRINT) statements that write to 
either unit 6 (explicitly) or to “*” (implicitly) anywhere in your user-code blocks, in the 
generated model source code (subroutine EQMO), or in any underlying library routines. We 
have found that MATLAB crashes under this circumstance for some unknown reason.

I reset the system date after installing MSC.EASY5, and now I get an error message 
that MSC.EASY5 has no valid license, because the system date was reset. What can I 
do?
Our license management software is very sensitive to resetting your system clock to help 
prevent certain modes of software piracy. Normally, the system clock should be set once 
during operating system configuration and left alone. If the license management software 
detects certain inconsistencies in system dates, MSC.EASY5 is disabled until these 
inconsistencies are corrected. Specifically, if any files have file creation timestamps which 
are after the current system date in either Windows or Windows system folders. These file 
creation date-stamps must be corrected by deleting them from your hard disk. Contact 
MSC.EASY5 Support for more information.

If I start EASY5 5.3 or greater, I get an X error in my Background Shell (or Command 
Shell window), and the graphical user interface does not appear. 
First, confirm that you are using Exceed 5.1.3.3 or higher -- we highly recommend 6.0+. 
Then, please confirm that all recommended Exceed configuration settings have been made. 
Finally, confirm that Exceed transport DLL files from MSC.EASY5’s “System” folder have 
been properly copied to the Exceed program directory (if the Exceed version is less than 
version 6.1). Contact MSC.EASY5 Support for more information.
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Troubleshooting

I can’t start MSC.EASY5 from the Start Menu or from the Desktop icon. It briefly 
flashes on the screen and then goes away.
This is indicative of an abortive error in MSC.EASY5. The EASY5 background window 
should still be displayed in Pause mode. Examine it to get some indication of what went 
wrong. If the background shell is not displayed, try launching EASY5 from an EASY5 
Command Shell in the Start Menu and entering the command: easy5x at the prompt. In this 
mode, the initiating Command Shell remains so that any messages displayed do not get 
inadvertently lost.

The MSC.EASY5 graphical user interface appears on screen, but I cannot enter any 
text into any of the text boxes.
Make sure that your Exceed configuration setting allows local X clients. Specifically, under 
Communications, the Mode value should be set to Passive. See “Exceed Configuration 
Settings” on page 48 for more information. For example, if you are trying to use 
Mode=XDMCP-query to set up an Exceed X terminal, it is recommended that you use 
Exceed Client or Session startup utilities to do this instead. In this way you can share Exceed 
between local and remote X clients without continuously changing configuration settings. 
Refer to your Exceed User Guide for further information.

Alternatively, if you have installed a different version of Exceed from that you had installed 
when MSC.EASY5 was originally installed, you need to reinstall MSC.EASY5.  Changing 
the version of Exceed can cause serious problems with MSC.EASY5, which needs to know 
which version of Exceed to setup for during its own installation.

A background window or windows keep popping up over the main EASY5 schematic 
window.
Set your Exceed  Focus policy to Pointer to eliminate this problem, which is caused by the 
interaction between EASY5, Exceed, and Windows.

I can’t access MSC.EASY5 menu items with the <Alt> plus key keyboard combinations 
as documented.
Try using the right <Alt> key; by default, the left one is provided for Windows use. The 
default Exceed configuration settings are to map the left <Alt> key for Windows, the right 
for X applications such as MSC.EASY5. You can change this by using the Exceed Xconfig 
program and selecting the Input icon.
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Troubleshooting

All my colors temporarily change during EASY5 executions, making the display 
difficult to read.
This is a known problem between Exceed and Windows color mapping and occurs because 
of interactions between various applications (such as Netscape Navigator, Microsoft 
Exchange) and Exceed. As soon as any action requiring a screen refresh occurs (i.e., 
examining a connection), the MSC.EASY5 colors return to their correct colors. Use the 
recommended Exceed configuration settings to avoid this problem, or use <Alt>R or choose 
View > Refresh to redraw the display.

Whenever any part of my pointer touches a Command Prompt window, the window 
automatically pops up. 
This is a known Exceed bug when the focus policy is set to Pointer. A window should only 
raise or pop to the top when the mouse touches the window title bar. This problem has been 
fixed with Exceed version 6.01.

I’m setting some MSC.EASY5 environment variables, but they are not working 
correctly.
Case must be observed for all MSC.EASY5 environment variables. Case is ignored under 
Window, but MSC.EASY5 is launched with a Unix Korn Shell, where case matters. Note 
that if you have already set an environment variable using the wrong case, you must first 
delete it before trying to correct the case (because Windows cannot detect the change). Also, 
make sure there are no spaces (blanks) before or after the variable value. Refer to your 
MSC.EASY5 User Guide or use the easy5x -vars command-line option for a list of 
available environment variables. See “MSC.EASY5 Environment Variables for Windows” 
on page 43.

Why are pathnames represented using forward slashes instead of backslashes?
MSC.EASY5 is actually launched from a Unix Korn Shell on your computer. Thus, the 
pathnames conform to Korn Shell syntax, which uses forward slashes instead of backslashes 
in file pathnames. Translate forward slashes to backslashes to determine the PC equivalent 
pathname.

MSC.EASY5 settings saved previously and transferred from a Unix system (e.g., 
temporary settings, plot variables, simulation form, and IC data) cannot be read 
properly.
All ASCII (text) files transferred between Unix and Windows systems must be transferred in 
ASCII mode. Typically, FTP programs are used to transfer file, and the appropriate 
conversion mode is automatically detected. However, you can override these settings and 
transfer text files in binary mode, causing read errors in either direction (Unix to Windows or 
Windows to Unix). Convert the text files as discussed in “Converting and Checking ASCII 
(Text) Files” on page 62.



Release Notes           77

TROUBLESHOOTING AND WORKAROUNDS

Troubleshooting

I noticed some environment variables which appear to have forward slashes in the path 
instead of backslashes commonly used in Windows.
During the installation, the Setup program sets four environment variables (HOME, ROOTDIR, 

TMPDIR, and SHELL) to certain Unix-style paths. Do not alter these environment variables 
used for the Unix Korn Shell, which requires the use of forward slashes. MSC.EASY5 uses 
the Korn Shell to run some scripts. See the man (help) pages for the sh command for more 
information by entering man sh from any EASY5 Command Shell. Also, refer to “Online 
Help” on page 27 for more information.

I don’t like the font and color selections provided by MSC.EASY5. Can I change them, 
and how?
The current version of MSC.EASY5 does not support changing font and color selections 
from within the program. New releases of MSC.EASY5 may support this with a new Control 
Panel capability.

Workaround: If you are experienced with using X Windows resources, you can adjust the 
program settings. The program settings are stored in the MSC.EASY5 resource folder (at 
%EZHOME%\easy5x\resource) in files named EZ5resource_<Xres> for each X-
dimension screen resolution. You can edit these ASCII files with any text editor; copy the 
contents of the MSC.EASY5 resource folder to your own folder and edit the resource files as 
appropriate. Then use the environment variable WSRESDIR to browse to your resource folder. 
This task is typically only for advanced programmers.

I am running with Interactive Simulation (IS) widgets, but they do not appear to 
remember where I placed them last time and are always displayed in cascaded form.
Check your Exceed configuration settings and ensure that you do not have the Cascade 
Windows Screen Definition option selected. This setting is the default, so you must deselect 
it. See “Recommended Default Exceed Settings for MSC.EASY5” on page 48 for more 
information.

I get different results from my simulation when I build the executable in debug mode 
than when I build it normally.
The Create Executable With Debug mode compiles your model using no optimization. This 
should always serve as the basis for what is correct. The optimization is usually performed by 
the compiler to improve the run-time performance of the code. If you do not specify debug 
mode or do not specify compiler settings (see “Overriding Default MSC.EASY5 Compiler 
Options” on p. 34), MSC.EASY5 uses the MSC.EASY5 compiler defaults (see “Default 
EASY5 Executable Options” on p. 32). First, compare the two generated Fortran files, 
preferably using some sort of different tool. 
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If they are the same (except for date/time stamps) this is usually an indication of a compiler 
bug. You can (1) change the compiler settings to use no or limited optimization (depending 
on the compiler), (2) try to find where in the generated (or user-defined) Fortran the compiler 
error occurred and try to modify the code (look for complicated looping, implied DO loops, 
or complicated logic statements), or (3) contact the compiler manufacturer directly to report 
a compiler bug. 

NOTE: A compiler bug does not mean a compiler error has occurred; you will 
see no compiler warnings or error messages. Rather, it means that the 
compiler has made a mistake in the way it has tried to optimize your 
generated (or user-defined) Fortran code.


